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1.0 Introduction 
 
Welcome to Omni CMS at the University of North Texas. This guide will help you get started as a content 
editor and familiarize you with Omni CMS’s terms, processes and other unique features.  
 

1.1 Omni Specific Files and File Types 
Omni uses a few proprietary file types that users may not be familiar with. The most common file type 
that editors will encounter is a .pcf file. This is a type of source file that is used to generate (or publish) 
corresponding .html files. Some of the files and file types to know about are:  
 

Omni File or Type Description 
.pcf The most common file type in Omni, used to 

generate published .html files. The published 
.html file will have the same file name. 
 

_nav.ounav Automatically generated when a new section is 
made. This file is used to generate links in the left 
sidebar navigation. 
 

_props.pcf Used to generate breadcrumb links. 
Table 1 - 1.1 Omni CMS Specific Files and Types 

1.2 Omni CMS File Naming Standards 
There are specific standards enforced for files created, uploaded or saved inside the Omni CMS 
environment. Omni only allows files (including images) to be named with: 

• Lowercase letters 

• Numerals (0-9)  

• Hyphens (-) 

• Underscores (_) 

• Periods (.) 
 
These rules are important for Omni CMS to function properly and cannot be adjusted or changed 
globally or on a site-by-site basis.  
 

1.3 Accessing Omni CMS at UNT 
The easiest way for users to directly access the Omni interface is to open a live page on a site they have 
permission to access. When on the live page, simply scroll to the bottom and click the small copyright 
icon at the very bottom.  
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This will open the Omni Interface’s preview view for that page.  
 

1.4 The Two Server System (Staging & Production) 
Omni CMS uses a two-server system so that content can be created, edited and maintained in a 
protected development space and then sent out to the world wide web when it is polished and ready to 
be seen. The two servers are Staging and Production.  
 
Staging is a development (or dev) environment that can only be seen by someone who has logged in and 
has permission to that site or folder. This is where all content is created and edited. When files, pages or 
other content is ready to be seen it can be published into the production environment.  
 
Production is the live server and can be viewed by anyone who navigates to the website. This is where 
all published files go.  
 

1.5 Omni CMS File Hierarchy and URLs 
Omni generates URLs for files based on where they are in the file hierarchy. Files in the root (or home 
folder) on a site will have the URL domain.unt.edu/file-name.html. Each folder after that is added to the 
URL in the following format: domain.unt.edu/[folder-name]/file-name.html.  
 
This means that a file named “may-2023-commencement.pcf” that is in the story folder of the News 
website will have the production URL of: news.unt.edu/story/may-2023-commencement.html.  
 

1.6 Dependency Tags  
Dependency manager keeps track of links in your website using Dependency Tags that point to pages, 
files or images Omni CMS. It prevents links from breaking when a file is renamed or moved, and tracks 
deleted content so you can easily identify and fix broken links. 
 
When you insert a link on a page or event, a dependency tag ({{f:####}}) is inserted into the URL source. 
Use the file chooser to link to Omni CMS content, rather than pasting in a full URL, to utilize the 
dependency tag.  
 
The dependency tag stays the same, even when the page or event URL changes. Omni CMS records the 
tag in the page content and inserts the current URL of the linked file when the page is published. 
 
Dependency manager keeps track of links to files in your Omni CMS account. It doesn't manage links to 
external websites. Dependency manager searches the staging server and the last published version of 
each publish target. 

2.0 Navigating in Omni CMS 
 
Using the top navigation bar, users can access their site, files and advanced settings. Keep in mind that 
each user’s navigation bar may not look like the example below because individual permission levels will 
change what options are enabled. 
 

2.1 Navigation Bar 
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Figure 1 - 2.1 Navigation Bar 

 
The main navigation bar will be visible whenever editors are logged in to Omni. The basic function of 
each item (from left to right) is: 

• OMNI CMS: This button will take users back to their home dashboard.  

• Dashboard: The Dashboard is the default start location and includes useful links for working in 
Omni, including checked-out content, recent activity and an inbox for messages internal to 
Omni. Users can also access their profile settings here.  

• Content: This menu is where users can access and edit web pages and other files.  

• Reports: From this menu users can run a variety of reports, find checked out content, see how 
files are being used and create custom reports.  

• Add-Ons (Advanced): This menu provides access to add-on features in Omni. This is generally 
for advanced users that have site-specific needs.  

• Setup (Advanced): This menu provides administrators with advanced site options and features. 
 

2.2 Dashboard 
The Dashboard menu has three options, Dashboard, Workflow and Inbox. The Dashboard itself (see 
below) provides a quick overview of the user’s recent activity and is useful for quickly seeing checked-
out content (yellow light bulb). The Workflow is used for content review and approval.  
 
It is recommended that users check the Dashboard when they are done editing to make sure that all 
content that is not being used is checked back in so that other editors can work on the files later. Files 
that are not checked back in will be locked and will not be editable by other users until they are checked 
back in. Some examples of when to keep content checked out are if publishing has been scheduled for a 
later time or if the file is incomplete and there is a need to prevent others from making changes.  
 
Users can click the title of the file in any Dashboard feed to be taken directly to that file.  
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Figure 2 - 2.2 Dashboard View 

 

2.3 Content 
The Content menu has two or more options, depending on your user level. For example, Pages and 
Assets for levels 0-4, with the addition of the Recycle Bin for levels 5-8. Level 9 and 10 users have 
additional options available to them. Selecting Pages provides access to the Pages List View, which is 
where you view the file structure of the website and can navigate to folders and pages to edit them. This 
is where the majority of website content is stored. Assets are a type of reusable content in Omni 
Update. 
 

2.4 Reports 
The Reports menu has several different types of reports that can be run to gather information on 
activity in Omni. These reports include: 

• Required Actions: Shows pages that have urgent problems, such as broken links, orphans and 
more. 

• Checked Out Content: Shows you pages that are currently checked out. Depending on user 
level, this will either show just your checked out content, or may include other users’ content as 
well. 

• Pending Approvals: Shows pages that are waiting for your approval. 

• Scheduled Actions: Shows any actions (such as publishes or reminders) the user has set. 

• Site Check: This report will check the site for broken links.  

• Custom Reports: This is where ad-hoc and custom reports can be run. There are a variety of 
options.  

• Recent Saves: Shows pages you saved recently. 

• Recent Publishes: Shows pages you published recently. 
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2.5 Add-Ons 
Add-Ons are optional links to applications or webpages that administrators can configure. The 
Marketplace item is available by default; this is where you can view new modules and gadgets offered 
by Omni CMS. 

2.6 The Staging and Production Environments 
These are two separate environments that will rarely, if ever, match each other 1:1. Content is created, 
edited and tested in staging and then published (or pushed) to production. Omni starts in the staging 
environment by default when the Pages List View (section 3.1) is opened. 
 
Key differences between staging and production:  

Staging Production 

• Only visible to authenticated users inside 
Omni CMS 

• Where documents can be edited 

• Files are created within the Pages List View 

• Visible to the public and search engines 

• Files in production are not editable. 

• Files are created when the corresponding .pcf 
in staging is published 

 
To switch between these environments, click the blue Staging (or Production) in the upper right of the 
Pages List View (section 3.1), below the + New button. This will open a dropdown where the desired 
environment can be chosen.  

 
Figure 3 - 2.6 Staging Pages List View with Highlight on Environment Selector 

 

 
Figure 4 - 2.6 Production Pages List View with Highlight on Environment Selector 

3.0 Creating & Editing Pages 
  
After navigating to the Pages View, pages can be previewed or edited. Pages must be checked-out with 
the lightbulb icon to edit them. 
 

3.1 Pages List View 
This is the main view in Omni CMS that editors will work in. From here, you can view all the folders and 
pages that you have access to on your website. Clicking on the name of a file will take you to Edit mode 
for that page; clicking the name of a folder will take you to the list view of the content within.  
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Figure 5 – 3.1 Page List View 

The view inside a folder is organized in a table, with each column providing information about the files 
(from left to right): 

• File Name: not necessarily the same as the page title. 

• File Size (unlabeled): try to keep images under 500KB to optimize loading times. 

• Status: available (light bulb outline), checked-out (yellow light bulb) or locked (red padlock). 

• Publish status (unlabeled): files in the above image have publishing disabled, but other 
publishing statuses included unpublished, unpublished with changes, or blank (published).  

• Modified: the last time the file was modified and saved, but not necessarily the last time the file 
was published. 

• More Actions Ellipsis (unlabeled): will provide additional actions depending on file, context and 
permission level. 

Some additional functions include the + New button at the top, which lets users create new content, the 
Upload button at the top for uploading files and the search bar which is used to filter or search for 
content. 

3.1.1 File Structure in Pages View (Note) 
Omni Update uses a file structure system to both organize pages and to create the structure of 
the website itself. For example, a page in the [folder] will have the URL of 
department.unt.edu/[folder]/page-title.html. 

There are also two expandable/collapsible regions on either side of the Pages List View. On the left side 
is the File Navigation Sidebar, which displays the file structure of the website, allowing you to expand 
and collapse folders without having to navigate to them. It can be a quick way to navigate through files. 
Selecting the lock icon will automatically sync the list to your location in the Pages List View.  



UNT Guide for Omni Editors 

 9 

 
Figure 6 - 3.1 Page List View Sidebars 

 
On the right side is the Gadgets Sidebar. Gadgets are utilities and programs in Omni that provide 
additional functions and shortcuts for common tasks. Some of these are standard and others are made 
on campus for our specific needs.  

3.2 Making a New Page 
To create a new page, first navigate to the appropriate folder in the Pages List View. It is important to 
remember that the URL for the page will be generated by appending the folder structure to the end of 
the domain. For example, a page in the “story” folder on the main UNT site will have the URL 
unt.edu/story/filename.html.   
 
In the desired folder, use the blue + NEW button to choose the new content to create. If the button is 
clicked it will open the New Content Modal box (left image below), while selecting the down arrow will 
open the New Content Dropdown (right image below). You can use either method to add your new 
content to the desired folder. 
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Figure 7 - 3.2 New Content Modal Box (left) and New Content Dropdown (right) 

At this point users can create new pages, folders and site sections.  
 
The next steps in creating new pages from both the modal box and dropdown are the same: 

1. Choose the template or layout for the content 
needed. 

a. For most general webpages “Interior 
Page” is a good and versatile choice. 

2. Click the title or thumbnail of the template. 
3. The new content details form (right) will open. 
4. In the New Content Details form, enter in the 

page title, short description, keywords and 
filename as guided by the form. 

a. Description and keywords are 
important to optimize for search, be 
sure to include them. 

b. The title and the file name do not 
need to be the same. The filename 
must follow the Omni CMS filename 
standards, whereas the title can 
include upper- and lowercase letters, 
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spaces, numbers and most characters. The title is more visible to users, so a descriptive 
title is important.  

5. Once all applicable fields have been filled out, click the CREATE button to make the new page. 
Omni will create the page and then open it in the editor view.  

 
The process to create folders and sections is similar. Both will create a new folder in the current folder, 
but a section will also create the following files within the new folder: 

• _nav.ounav: This file is used for setting up left sidebar navigation on pages within the folder.  

• _props.pcf: This file is used to populate breadcrumbs. If it is deleted or if “$skip” is entered into 
the source of the props file, the current folder will not show in breadcrumbs.  

• index.pcf: This functions as the home page (or landing page) for the folder. When external users 
click the folder’s name in the breadcrumbs, the index page will load.  

 

 
Figure 8 - 3.2 Files created within a new section. 

The New Section modal box (right) will 
guide you through the process of making a 
new section. The folder name must also 
follow the Omni file naming standards (no 
capital letters, no spaces, etc.).  
 
Once the new section has been created, 
omni will open index.pcf in edit mode for 
the user.  
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3.2.1 Why can’t I edit nav.ounav and _props.pcf? 
It is important to remember that because editing _nav.ounav and _props.pcf requires source 
code access, not all users will be able to edit them. Editing these files depends on your 
permission level.  

 

3.3 Page Actions Toolbar 
Once a page has been selected to be edited (or created) the page will be loaded for preview and 
editing. The page action toolbar is used to switch between preview, edit, source (advanced users 
only), properties and versions.  

 

Figure 9 - 3.3 Page Action Toolbar 

Additional functions on the toolbar, from left to right, include Checking Content In or Out, Publish, 
Focus Mode, and the More Actions Ellipsis. Checking content in and out and publishing will be covered 
more later.  

3.3.1 Why did the page actions toolbar change? (Note) 
The Page Actions toolbar will change depending on the status of the page (if it is checked out or 
not). Remember, when a page is published, it will be checked in and the toolbar will change. If 
you need to make another edit after publishing a page and can’t find the option, make sure the 
page is checked out.  

 

Figure 10 - 3.3 Focus Mode Active 

Focus Mode will toggle between the default view and a minimized toolbar view that takes up less 
vertical space on the page. The More Actions Ellipsis is used in many places throughout the Omni 
interface, and the actions available will vary based on context and your permission level.   

3.4 Checking Out Content (Pages, Images and More) 
The first step in editing a page is checking it out. Checking out a page in Omni locks access to one user so 
that no one else can make changes while it’s being edited.  

To check out a page, simply click the lightbulb icon for the page, turning it yellow. When other users 
view the page, there will be a red lock icon in the place of the lightbulb. This means the page is locked 
for editing. Only higher permission level users can break this lock.  
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Figure 11 - 3.4 Examples of Checked-out icons in the Pages List View 

3.4.1 Can’t find a file’s parameters or versions? (note) 
Checking out content should be the first step in editing. Some menu items, parameters, settings 
and versions will not be available until the file is checked out. Files will automatically be checked 
out when you click an editable area, even if that was not intended. Because of this, it is also 
important to check in content when you are done with it so others can have access to them.  

 

The yellow lightbulb icon can be found in multiple locations: 

• In the Page Actions Toolbar at the top of a page when you’re viewing it (section 3.2). 

• In the Page List View (section 3.1). 

• In the Dashboard’s my checked-out content (section 2.2). 

• The “My Checked Out” Content Gadget. 

• The Checked-Out Content Report (section 2.4). 

3.5 Opening a file in Edit Mode 
To open a page, click its name while in the Pages List View. You can also click the More Actions Ellipsis 
and then select Edit -> File. Remember, the options available when you click the More Actions Ellipsis 
will vary based on context and permission level.  

 
Figure 12 - 3.5 Opening File in Edit Mode 

 
The file will open in Edit Mode. This can be checked by looking at the active tab in the Page Actions 
Toolbar (section 3.3).  
 

3.6 Editable Regions  
Once a page is opened in Edit Mode, you will need to select the region you need to edit. Different page 
types will have different editable regions. Some editable regions will need to be enabled or disabled, 
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and some page types will have a multi-edit form rather than editable regions. The Interior Page is a basic 
page type that is versatile and can be built out for almost any need, so all examples will use the Interior 
Page template.  

Each editable region’s label is a green button that is also used to access that region. Clicking a green 
button will open that editable region. To change from one editable region to another, the page must be 
saved to close the edit content view. You can click the preview button in the Page Action Toolbar to 
discard changes. Unsaved changes are not recoverable.  

 
Figure 13 - 3.6 Editable Regions on a Page 

 
After clicking a green button, you can type in the region, edit text, and insert images, links, and other 
content while being able to see what the changes will look like on the published page. This is called the 
WYSIWYG Editor (What You See Is What You Get). 
 

3.7 The WYSIWYG Toolbar (UNT Toolbar) 
The toolbar at the top of the editing window contains much of the same functionality as common word 
processors, such as font styling and alignment, spellcheck, and lists, as well as the ability to insert 
content like images, tables, links, snippets, assets and components (snippets, assets and components 
are Omni-specific elements that will be discussed in section 8). To save your changes and exit the 
editable region, select the Save and Exit icon in the very top left corner of the toolbar or the blue save 
button on the top right.  

3.7.1 My Browser doesn’t support direct access to the clipboard (Note). 
It’s recommended that you use the keyboard shortcuts Ctrl/Cmd + C and Ctr/Cmd + V to copy 
and paste, respectively, rather than the icons on the toolbar, as some web browsers block copy 
and paste buttons from working.   
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Figure 14 - 3.7 WYSIWYG Toolbar Map 

What’s on the WYSIWYG Toolbar: 

1. Save and Exit buttons. 
2. Styles: use the paragraph, heading and other styles to change the text size and create emphasis. 
3. Paste: This will paste the latest item from your clipboard. The WYSIWYG will bring some, but not 

all, formatting from the word processor in when something is pasted, which can cause 
unexpected page behavior and formatting issues. To avoid this, use the paste as text option to 
remove styling.  

4. Spell Check Tool. 
5. Image and Video Tools: This will open the insert image or video dialogue box.  
6. Code Peek (advanced users only): This will let users see the HTML code for the content in the 

WYSIWYG.  
7. Snippet Tool: Allows users to select and insert snippets into the page. 
8. Asset Tool: Allows user to insert assets into the page. 
9. Component Tool: Allows users to insert layout components into the page. This tool is very useful 

for quickly creating quality layouts for both text and images.  
10. Table Tool: Allows the users to create a table. Tables can also be created by copying from 

Microsoft Excel.  
11. Alignment: alignment can be used for text and images. Images will be “floated” to the left or 

right with alignment, which will allow text to be displayed next to them on the other side.   
12. Link Tool: Allows the users to create links.  
13. Mail To Tool: Creates a mail-to weblink to embed emails into a page. 
14. Anchor Tool: Creates HTML Anchor tags to facilitate linking within a page.  
15. Help Button. 

3.8 Inserting a Link 
Links in Omni are usually added via the WYSIWYG Toolbar. Omni provides additional functionality to 
links, called a Dependency Tag, that can be a powerful resource to web content editors. Dependency 
Tags allow editors to link to content without using a relative path, which means a link to a page or image 
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won’t break even if the URL changes or the file is moved to a new folder. Dependency tags can only be 
used to link to content within an Omni site. As a general practice, dependency tags should be used 
whenever possible.  

To insert a link on a page: 

1. In an open editable region, highlight the text that you want to turn into a link. 
2. In the toolbar, click the Insert Link button (section 3.6 – WYSIWYG Toolbar Map #12) to open 

the link dialogue box.  

 

Figure 15 - 3.8 Link Dialogue Box 

3. To insert an external link (i.e., a URL not managed in Omni by UNT) copy and paste it into the 
URL field. Then skip to step 8. 

4. To insert an internal link, select the file chooser icon (box with arrow pointing into it) to the right 
of the URL field. 

5. Navigate through the file structure to select the page you want to link to. Once you’ve chosen a 
page, select Insert. Note: to choose a home or landing page, choose the file named 
index.pcf/html in that site’s folder. 

 

Figure 16 - 3.8 Internal Link File Chooser with Preview 
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6. The above image shows the last step before inserting a link as a dependency tag. The preview 
window is useful for verifying the content being chosen before you click the INSERT button. The 
target can be selected in either the Production or Staging environment. If a file is chosen in 
staging, Omni will verify the production target for the link.  

7. Notice what appears in the URL field – this is a dependency tag. Omni CMS uses something 
called Dependency Manager to keep track of, and link to, internal files. Each file is assigned a 
unique tag that can be inserted as a link. This way, the link remains valid even when the file is 
moved or renamed (but will break if a file is deleted).  

 

Figure 17 - 3.8 Dependency Tag Example 

8. Other fields include:  
a. Title: which is the text that displays when users hover their cursor over the link. 
b. Open Link In…: where editors can choose if the link opens in a new window or not. 
c.  Class: where button styles can be applied to the link. 
d. The Custom Class and Advanced tab also provide additional configuration options for 

advanced users. 
9. Finally, click SAVE to place your link on the page. 

 
To edit an existing link, place the cursor in it and then select the Insert/Edit Link icon from the toolbar. 
The Remove Link button is also available next to it. The edit link menu can also be accessed by selecting 
the link text and right-clicking on it.  

 

3.9 Inserting Images 
Images can be inserted into most WYSIWYG sections, as well as inside of components. The method to 
insert an image in either scenario is generally the same. The only major difference between inserting an 
image in a page and adding one to a component is how the process is initialized; in a component the 
image insertion will be part of the component creation form.  

To place an image on a page:  

1. In an open editable region, place your cursor on the page where you want the image to be. 
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2. In the WYSIWYG toolbar (Section 3.6), select the Insert/Edit Image icon (#5 on the map).  
3. In the Source field, click the file chooser icon (box with an arrow point up into it, same icon as 

the file chooser icon for links).  

    

Figure 18 - 3.9 Insert Image Box                                                                                           Figure 19 - 3.8 Image File Chooser Box 

4. This will open the file chooser dialogue box, in which you can navigate to the desired image.  
5. Use the file chooser to navigate through your website’s file system and find the image you want 

to add. Once you’ve chosen an image, select INSERT. 

6. Alternatively, if you want to insert an image that hasn’t been uploaded yet, you can use the 

Image File Chooser to navigate to the appropriate images folder and click the UPLOAD button in 

the upper right corner to add your new image to that folder. 

7. Fill in the Alternative Description field, which populates the image’s “alt” tag. This is mandatory 

for accessibility standards. 

8. You can also add an Image Title, which doesn’t need to be as descriptive as the Alternative 

Description. 

9. The Dimensions (Width and Height) of the image can also be altered from this window, but 

make sure the lock icon is activated to avoid stretching or skewing the image by only altering 

one dimension.  

a. Note: This option should rarely be used because best practice is to upload an image 

that’s already the exact dimensions you need so that the file size can be optimized. 

Using this method to make an image display smaller means the page is forced to upload 

a larger file than is necessary and using it to make an image display larger can make the 

image appear blurry or pixelated. 

10. The Advanced Tab lets you specify alignment (float), spacing, border width and some CSS style.  

11. Once you’re done, click SAVE to place the image on the page. 

Images can also be uploaded to a folder on the site database. In order to upload an image: 

1. Navigate to the desired upload location (folder). 
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2. Select UPLOAD from the top toolbar, on the side of the + NEW content button.

 

Figure 20 - 3.9 Upload button in the Pages List View 

3. Using the upload dialogue box, choose the + ADD button to open a file browser and select the 

image to upload. 

 

Figure 21 - 3.9 Upload Modal Box detail. 

4. After adding the image file, it may need to be renamed to comply with the file naming standards 

(no capital letters, no spacing, etc.). 

 

Figure 22 - 3.9 Invalid file name error message. 

5. Click the More Actions Ellipsis and choose Rename, then correct the name so there are no 

spaces and no capital letters. The only permitted characters are: lowercase letters, numbers, 

and the (-) and (_) symbols. 
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6. Once the name is fixed, it will still show as red (see image below). Click anywhere inside the 

dialogue box (ex. in the white space) to finalize renaming it.  

 

Figure 23 - 3.9 Corrected file name. 

7. After this, the START UPLOAD button will no longer be grayed out and the file can be uploaded.  

8. Publish the image by checking the box to the right of it in the Pages List View, and then using the 

toolbar at the top to publish it.  

 
Unpublished images are not visible on published pages! 

3.9.1 Why doesn’t the picture show on the published page? (Note) 
Images must be published to load on published pages. If a file is only uploaded to staging, it 
won’t exist on the production server (where published pages are). If images are not showing up 
on the page, double check if they are all published.  
 

3.10 Inserting a Video 
To place a video on a page: 

1. In an open editable region, place your cursor on the page where you want the video to be. 
2. In the toolbar, click the Insert/Edit Video button (section 3.6, #5 on the WYSIWYG Toolbar 

Map). 
3. To insert a video that has been uploaded to Omni CMS, select the file chooser icon in the Source 

field and browse for the video. 
a. Below the Source field, users can specify the video’s width and height.  

4. Once you have found the video file, click Insert. 
5. To embed a video from an external source (such as YouTube), past the video URL in the Source 

field, or paste the generated embed code in the Embed tab.  
6. In the Advanced Tab:  
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a. Alternative source is where users can enter a backup file in case the video doesn’t 
display properly. 

b. Media Poster is where you can upload a thumbnail. 
7. Click OK to place the video on the page. While in edit mode, you’ll only see the video as a gray 

box; save and exit the editable region to see how it will display on the published page.  

4.0 Using Snippets, Components and Assets in Omni CMS 
 
Snippets, Components and Assets are types of reusable content in Omni CMS. Editors can place them 
into the main WYSIWYG sections on a page using the WYSIWYG Toolbar (section 3.6). Once placed, the 
user will be able to add in their own content or take advantage of pre-made content that will be 
automatically styled and produce great looking pages easily and quickly. These content types are 
created centrally by designers and programmers and then shared to the campus community. If you find 
that there is a common task, information block or layout that is being frequently reused, it might be 
possible to make it into one of these design elements.   

Snippets are content that you insert onto a page and can then edit without changing the original file. 
Often, they are used to make items such as accordions, tables or image frames, where the snippet 
provides the styling, and the editor fills in unique content when it is placed on the page. Snippets are 
formatted as a table, so when editing them the editor will place content into the fields as labeled by the 
table’s header.  

Components are content blocks that the editor populates by putting content into the component form, 
which Omni then populates into a preset style and layout. Components are like snippets but are not 
edited via tables and can have more complex layouts and interactions. Additionally, components can be 
used to easily embed content into omni pages, such as media, forms and more.  

Assets are files created and managed separately from pages; when you place an asset on a page, you 
cannot edit the content. However, when an asset file is edited, every page containing that asset is 
republished to reflect that change. Assets are useful for placing the same information across multiple 
pages, such as a university address or phone number. This way, if the information changes, the original 
asset only needs to be modified once, as opposed to editing it on each page it appears. 

4.1 Placing Snippets 
1.  In an open editable region, place your cursor where you want the snippet to appear. 
2. Click the Insert Snippet icon on the toolbar (section 3.6, #7 on the WYSIWYG Toolbar Map). 
3. Choose a snippet from the ones available. You can see a basic preview of what it will look like on 

the right-hand side. When you’ve selected one, click INSERT.  
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Figure 24 - 4.1 Snippet Preview 

4. Now that the snippet is placed on the page, fill out content in the appropriate areas. A placed 
snippet is formatted like a table in the editor (notice the table controls that float near the top in 
the screenshot). If you want to add additional content, such as more items in this accordion, add 
rows below the lowest table row.  

 
Figure 25 - 4.2 Editing Content in Placed Snippet 

5. To see what the snippet will look like on the published page, save and exit the editable region.  

4.2 Placing an Asset  
To insert an asset: 

1. In an open editable region, place your cursor where you want the asset to be placed. 
6. Click the Insert Asset icon on the toolbar (section 3.6, #8 on the WYSIWYG Toolbar Map). 
2. Select an asset from the file chooser. Assets come in five types: Web Content, Plain Text, Source 

Code, Image Gallery and Form. 
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Figure 26 - 4.2 Asset Preview 

3. Once you’ve chosen an asset, click INSERT to place it on the page. While in an editable region, 
the asset will display in a rounded box with the text “Asset [name] cannot be shown in 
WYSIWYG,” to indicate you cannot edit the content of the asset. 

 

Figure 27 - 4.2 Asset placed in WYSIWYG editor. 

4. To see how the asset will look on the published page, save and exit the editable region. 

 

Figure 28 - 4.2 Asset in published page preview. 

4.3 Placing Components 
To insert a component:  

1. In an open editable region, place your cursor where you want the component to appear. 
2. Click the Insert Component icon on the toolbar (section 3.6, #9 on the WYSIWYG Toolbar Map). 
3. Choose the component using the dialogue box. Note that the component will not appear in the 

preview area, just the component icon. 
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Figure 29 - 4.3 Component chooser dialogue box. 

4. After selecting a component, use the INSERT button to place it. 
5. Once the component has been inserted, the component content form will pop-up and guide you 

through the process of adding content into the component. For this example, the “Split Image” 
component was used.  

     

Figure 30 - 4.3 Split Image Component Form (top -left, bottom - right) 

6. When populating content into the component form, keep in mind: 
a. Not all fields are required, optional fields will be labeled.  
b. The image chooser will be the same as any other image insertion process.  
c. Be sure to check each setting. Some, like the checkbox for “add space above and below 

a Split Image Overflow,” are only used if the overflow style has been selected. 
7. When adding links, always check for a link field at the bottom. This will create a button link 

inside the component. These links are generally more accessible and easier to use on mobile. 
When labeling a button link, be descriptive. The label should tell the viewer both why they 
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should click it (a call to action) and where it will go. Add additional links with the + ADD NEW 
GROUP button.  

 

Figure 31 - 4.3 Adding links to component. 

8. When finished, click SAVE at the bottom of the component form.  
9. The finished component can now be previewed. 

 

Figure 32 - 4.3 Preview of placed split image component. 

10.  To edit it again, select the component in the WYSIWYG editor and choose the pencil icon (the X 
icon will delete the component). 

 

Figure 33 - 4.3 Component edit and delete icons. 

5.0 MultiEdit Pages 
 
You may come across pages that do not have editable regions as described on Interior and Landing 
Pages, but instead a MULTIEDIT button at the top of the page to the left of the check-out icon and the 
green PUBLISH button. 
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Clicking the MULTIEDIT button will check out the page and open a form-type interface where you can 
enter information into the page with limited ability to edit the styling or formatting. MultiEdit is 
commonly used for pages such as faculty profiles, where the content will change but the format is 
meant to stay consistent. 
 
Some common page types at UNT that use the MultiEdit format are the People Detail Page and the 
Program Details Page.  
 

6.0 Editing Page Properties & Parameters 
 
Some information on a page is edited via Properties, rather than through the WYSIWYG editor.  

6.1 Accessing Page Properties & Parameters 
Page properties can be found in the Page Actions Toolbar if the page is checked out. Note in the first 
image, that when the page is not checked out there are fewer options available.  

  

Figure 34 - 6.1 Properties view without checking-out a page. 
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Figure 35 – 6.1 Properties view with page checked out. 

You can also access them by hovering over the file in the Pages List View and selecting Edit > Properties 
(again, this will only appear if you’ve checked out the page). 

 

Figure 36 – 6.1 Accessing properties from the Page Listing View 

Note: Depending on your user settings, you may not have access to Page Properties. 

There are four items under Properties: 

• Parameters: This includes metadata about the page, such as title and description, as well as 

different configuration options. 

• Reminders: You can set Scheduled and Stale Reminders for a page, to notify you either to 

publish a page at a certain time or when a page has gone unedited for too long. 

• Log: Tracks all the changes that have been made to the page. 

• Instinct™: Advanced user feature for page forwarding, an upcharge feature that is not currently 

included in our contract with Omni CMS. 

6.2 Editing Page Parameters 
Page Parameters is divided into two sections: 

Title and Metadata is the first parameter field. The Title and Description fields are displayed when the 
page comes up as a result on a search. In addition, the page title will usually be displayed by browsers 
on the tab the page is in. Tags are used within Omni to organize and sort files; your site administrator 
may have specific guidelines for tagging content that they want you to follow. 

Custom Settings can vary from page type to page type. These often cover settings such as the header, 
breadcrumbs, an image for the page, whether to display right and left columns, and other options for 
configuring content outside of the editable regions on the page.  

6.2.1 Setting a Hero Image in Omni (note) 
The hero options and page title options are how to add a hero image to the page. Inside the 
page parameters, under custom settings, users can set hero options from None to Hero Section. 



UNT Guide for Omni Editors 

 28 

Then set page title to Hero Style and choose a background image.  

 

Figure 37 - 6.2.1 Hero section settings. 

In the above image, the Hero section has been set and a picture has been selected.  

6.2.2 What size should a Hero Image be? 
In Omni, only one image is uploaded for the hero banner. This means that it needs to work well 
across screen sizes and be optimized for the web. Some tips for getting the image right: 

• In an offline editor (like Photoshop) crop the image to a 16:9 ratio. When cropping, pay 
attention to select the focus on the image on the “action,” such as a person’s face. This 
is important because otherwise the image may load with the focus cut off.  

• Resize the image (after it is 16:9) to be 1600px across. This will make sure that the image 
won’t need to be stretched out on large screens. 

• Compress the image when saving so it is less than 500KB, 300-350 is generally a good 
target. This is very important for page load times, which is a factor in search engine 
optimization.  

 

6.3 Setting Reminders 
There are two types of reminders you can set in Omni Update for a page. A Scheduled Reminder sends 
you a notification on the specified date and time, with the option to repeat the reminder. A Stale 
Reminder is only triggered if the page has not been edited within the specified period of time.  
 

6.4 Using the Log 
The log lists times when the page has been saved or published, and where it was saved from. This can be 
useful to look back and see who made edits and when. This is not the same as Versions, because it is not 
possible to revert to a past version in the log.  
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7.0 Page Versions 
While working on a page, you may want to back up the current state before making any changes so you 
can revert to a previous version if you don’t like the changes. To save a version of a page, make sure the 
page is checked out, and then click the Save Version in the Page Actions Toolbar (accessed by clicking 
the More Actions ellipsis). Be sure to enter a description to indicate what changes were made from the 
previous version and include any other useful information.  Additionally, a version of the page will be 
saved each time it is published. 
 

7.1 Reverting a Page 
To revert a page to a previous version, first access the versions tab from the Page Actions Toolbar 
(Section 3.2). This screen will list each version (organized by version number) and include the date when 
that version was published, who published it, and any description or notes that were added.  

 
Figure 38 - 7.1 Page Versions Screen 

 
From the versions tab, you can click the More Actions Ellipsis to access these functions:  

• View: See what that version of the page looks like. 

• Compare: Compare that version of the page with the version you’re currently working on. 

• Revert: Change the version you’re currently working on to the highlighted version. 

Keep in mind, the options available to each user will depend on their individual permission levels. You 
can use the view option to review a previous version before reverting, and once the desired version has 
been identified, revert using the revert function. It is also a good idea to save a version of the current 
page before reverting to mitigate the risk of losing content.  

8.0 Publishing, Scheduling and Expiring Content 
 
Omni Update uses a two-server system. This means that any changes you make to pages are on the 
staging server, while the live website exists on the production server. This allows you to edit and create 
new content without worrying about web visitors seeing it until it’s ready to be published. To make 
changes go live, you simply publish your content. 
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The ability to publish pages directly without submitting them to another user for review and approval is 
determined both by user level and/or administrator-configured settings. This section will discuss both 
publishing a page directly and submitting it to a workflow.  

When publishing files directly, users will receive a success confirmation message with a link to the 
published page (or an error message if the publish was unsuccessful).  

8.1 On-Demand Publishing 
There are several ways you can publish a page: 

Via the PUBLISH button in the Page Actions Toolbar (section 3.2). 

 
Figure 39 - 8.1 Highlight of the Publish Button on the Page Action Toolbar. 

In the Pages List View using the More Actions Ellipsis (section 3.2) and selecting Publish from the 
dropdown menu.  

 
Figure 40 - 8.1 Publishing using the More Actions Ellipsis. 

You can also Schedule and Expire pages from this menu. These functions are discussed in more depth 
later in Section 8. 
 
Content can also be published in batches from the Pages List View. To do this, select multiple items 
using the check box to the left of each file’s title. 
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After selecting items, additional functions will appear in the Pages List View Toolbar. Select publish to 
see the batch publish dialogue box. 

 
 
The Batch Publish Dialogue Box provides several functions (depending on permission level):  

• Include Checked-Out Files: Publish files in the folder that are checked out by any user. The files 
stay checked out after publishing.  

o Depending on your permission level, it may not be possible to force publish checked out 
files. For example, if an administrator has the file checked out, it is not possible to force 
publish without first getting the file checked back in. 

• Include Files Scheduled for Publish: Publish files in the folder that are scheduled to be 
published. The files stay scheduled to publish after publishing.  

• Include Files in Workflow: Publish files in the folder that are part of a workflow. The files remain 
in the workflow after publishing.  

• Publish Changed Files Only: Publish files that have been modified since their last published 
version. This includes checked-out files and newly created files that have never been published.  

• Use Last Published Version: Publish the version of the file that is currently live on your site. If 
the file has unpublished changes, they will not be published.  

o This can be useful if a design change or some other modification requires a republish of 
the folder, but you don't want to update the content. 

• Publish Target: Publish files to a different location than the live website.  
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o Note: This function is only present if your website has been set up with more than 
one Publish Target (ex.: production and development environments).  

• Version Description: Add a description to the version history of every published file in the 
folder. This is important for looking back at why the file was published and if the version needs 
to be reverted.  

 
Once all desired options have been selected, click PUBLISH. The system will process the files, but 
depending on how many were selected it may take longer than usual for them all to be published. When 
publishing in batches, the published flies will not have pop-up banners with links to each file (unlike 
when publishing individual files), but rather one message of “X# of files have been successfully 
published.”  
 

8.2 Viewing Published Files 
Published pages can be reviewed by selecting “View Published Page” from the More Actions Ellipsis on 
the Page Actions Toolbar in editor view (see below). 

 
Figure 41 - 8.2 Viewing Published Pages 

 
Published files can also be viewed by changing the pages list view from staging (Figure 43 below) to the 
production environment (Figure 44 below). 

 
Figure 42 - 8.2 Staging Pages List View 
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Figure 43 – 8.2 Production Pages List View 

In the production environment’s Pages List View, you can click any file to see the live page. Generally 
speaking, users should use the .html files to see what their live site looks like and to find the live URL of 
their pages. The other files in the folder help the site to function and are not meant for site visitors to 
see individually. 
 

8.3 Schedule Publish 
Omni’s two server system (staging and production) allows you to make edits and create content in 
advance of when it needs to go live, and then schedule it to be published to production at the proper 
time and date. This is useful, for example, for announcements, news and other time-sensitive or 
seasonal content.  

Scheduling content to publish can be done from the same locations as publishing it directly: from the 
drop-down menu on the More Actions Ellipsis in the Pages List View, from the “Schedule” tab in the 
Batch Publish modal, or from opening the dropdown of the green PUBLISH button.  

 
Figure 44 - 8.3 Detail of Publish Button dropdown box options. 
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All these methods will open the “Schedule” tab of the Publish modal.  

 
Figure 45 - 8.3 Schedule Modal Box. 

The options in the Schedule modal box are: 

• Date: The specific date to publish the file. 
• Time: The exact time to publish the file. 

• Repeat Every: Schedule the page to republish at a set interval. 

• Notification: Create a notification of the scheduled publish, as appropriate. Select the "Send 
Copy to Email" checkbox to receive an email notification in addition to a message in your Omni 
CMS inbox. 

 
Files that are scheduled to publish display a calendar icon in the status column on the Pages List View. 

 
Figure 46 - 8.3 Schedule Icon Detail in Pages View 

 
If a publish you scheduled fails, you will get a failure message either via email or your Omni CMS inbox. 
Omni CMS will attempt to publish the page two more times at fifteen-minute intervals. If the publish still 
fails, the scheduled publish is removed and another message will be sent to you. 
 

8.4 Removing a Scheduled Publish 
A scheduled publish can only be removed by the user who set it or by level 9 and 10 users. To remove a 
scheduled publish, either: 

• In Pages, click the calendar icon from the status column. 

• While viewing the page, click Remove Scheduled Publish. 

• Reschedule from the Scheduled Actions report. 
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8.5 Expire 
Files can be scheduled to expire at a specific date and time. An expired file is either recycled, replaced 
with another file, or has a redirect created in its place, depending on what settings are selected when 
the expire is configured. 
 
To expire a file: 

1. Navigate to the file in the Pages List View (section 3.1). 
2. Click the More Actions Ellipsis (to the right of the last modified date). 
3. Click Publish -> Expire. 

 
Figure 47 - 8.4 Schedule Expire Modal Box Detail 

4. In the Schedule Expiration box, choose from the following expire types:  
o Replace: Swap the expired file with the contents of another file. Click the file chooser to 

locate a replacement file (this file isn't affected by the expire). 
o Recycle: Send the expired file to the recycle bin. Recycled files can be recovered and 

restored to their original folder. 
o Redirect: Divert web visitors to the URL entered in the "Redirect To" field. Only available 

for non-PCF files.  
5. Choose a date and time for the file to expire.  
6. Create a notification of the page expiration, as appropriate. Select the "Send Copy to Email" 

checkbox to receive an email notification in addition to the message in your Omni CMS inbox. 
 
After the expire has been set, the Expire icon will replace the lightbulb icon in the Pages List View so that 
users know that file is scheduled to expire.  
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Figure 48 - 8.4 Expire Icon Detail 

8.4.1 Checking my scheduled publish and expire actions. 
Users can check their files scheduled to be published or expired in the Scheduled Actions Report 
(section 2.4). The status icon will indicate what action is scheduled. The report will also indicate 
the owner of the schedule, the target for publishing, and the date and time of the action.   

 
 

 

8.5 Workflow 
Depending on user permissions or the access settings of a page or directory, editors and reviewers may 
not be able to directly publish a page. If this is the case, they won’t see the green PUBLISH button in the 
Page Actions Toolbar; instead, it will say SUBMIT. The Publish option is also replaced with Submit when 
the More Actions Ellipsis is selected in the Pages List View.  

8.6 Submitting for Approval (Workflow) 

• Click Submit. 

• Select an approver. 
o If the approver has been enforced by your administrator, then you cannot select a 

different approver. 

• Write a subject for your message. 

• Write a message, as appropriate. 

• Choose to send an email to the user along with the Omni CMS message. 

• Click Submit.  
o The file is now locked to the approver. 

8.7 Approving or Declining to Publish 
You can view files submitted for your approval in Dashboard > Workflow. There are four actions that 
can be taken on a submitted file: 

• Publish a file submitted for approval the same way you would normally publish a file. 

• Schedule a file to publish later. 

• Reassign the file.  
o This can be useful for sending the file to another user to approve/publish. 

• Decline the file to reject the publish.  
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o The file is checked in and available for additional edits.  
o Select the "Revert to Previous Version" checkbox to discard edits since the last saved 

version. 
When you publish, schedule, reassign or decline a file that was submitted to you, you can also send a 
message with the page. These messages are visible for each file in Dashboard > Workflow. 

9.0 Recycling and Deleting Files 
 
Recycling a file removes it from its original folder and from your live website and sends it to the recycle 
bin (where it can be restored or permanently deleted). Users levels 8 through 10 can recycle files, while 
users levels 1 through 7 can be given permission to recycle and access the recycle bin. 
To recycle a file: 

1. Navigate to Content -> Pages to open the Pages List View. 
2. Click the More Actions Ellipsis. 
3. Click File -> Move to Recycle Bin. 
4. The "Move to Recycle Bin" modal box lists links that will break because of the recycle. Manually 

fix any broken links.  
a. Though dependency manager tracks links, it cannot fix the links listed since they point to 

a file that will no longer exist on the production server. 
5. Click Move to Recycle Bin. 

 
To recycle multiple files, select their checkboxes and click Move to Recycle Bin in the list header. 
 
Recycle files from the staging server to remove published versions from the production server. If you 
delete a file from the production server, republish the corresponding file from the staging server to 
restore the live page. You cannot recycle files that are checked out to another user, in a workflow, or 
scheduled to be published. 
 

9.1 Recycle Bin 
To access the recycle bin: 

1. Click Content -> Recycle Bin to see files, their original location, who recycled them and when.  
2. Click the More Actions Ellipsis to Restore or Delete files. 
3. Restoring a file or folder returns it to its original location on the staging server.  

a. Publish the file to restore it to your live website. 
b. A restored file generates a new Dependency Tag, and you must update the links that 

point to the old tag. 
4. Deleting a file permanently removes it from Omni CMS, with no way to bring it back. 

 
To restore or delete multiple files, click the file checkboxes and select the appropriate option from the 
list header. To restore a folder and its files, select files with the same original location and recycle date. 
Click Delete All to permanently delete all files in the recycle bin. 
 

9.2 Deleting a file from Production (unpublishing) 
The process to delete files from the production server is the same as recycling from staging, except that 
the source file will still exist in the staging server folder, and it can be republished at any time without 
having to restore it from the recycling bin.  
 

https://support.moderncampus.com/learn-omni-cms/administration/setup/users.html#usersettings
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To delete a file from production: 
1. Navigate to the file you want to delete in the Pages List View in the production environment. 
2. Click the checkbox for the file(s) that need(s) to be deleted to change the context of the table 

header functions.  

 
3. Click the delete button (it has a trashcan icon).  
4. A modal prompt will open requiring the user to confirm the delete.  

 
5. Upon confirmation, the file will be deleted. This is permanent and can’t be undone, but the file 

can be republished from staging to production. 
 
To restore a file deleted from production, simply republish the source .pcf file. In this example, the 
people-detail.pcf template produces both a .html and .xml file in the production server, so publishing 
the people-detail-balloon-scrappy.pcf in the staging environment will restore both files to the 
production environment.  
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